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1 Welcome

Welcome to Outlook-To-ACT Migration Professional!
The most complete tool to create an image of your Outlook Database in

ACT!.
Compatible with ACT! 2000 and 6.0 and Outlook 2000, 2002, and 2003

With Outlook-To-ACT Migration Professional  you'll be able to:

· Migrate an unlimited number of contact from Outlook into ACT!
· Maintain all the tasks (todo's), appointments, journal items, attachments, etc..
· Effortlessly bring over any amount of data from Outlook into ACT!
· Guarantee that all the data in Outlook is properly mapped, transferred, and represented in

ACT! in useable form.
· Convert User Defined Fields in Outlook into ACT! fields
· Convert the following activities from Outlook:

Tasks - Convert them into ACT! Todo's
Appointment - Convert them into ACT! Meetings
Quick Notes - Convert them into Outlook Notes.
Journal - Convert Outlook Journal entries into ACT! History/Notes, including emails and
attachments

· Full support for Outlook Local and Exchange Public Folders
· Outlook-To-ACT Professional converts the whole database in one click. Our innovative

Outlook Warning Suppression mechanism ensures that your conversion only stops when all
contacts are converted

· Last but not least, leave your computer and let Outlook-To-ACT Migration Professional do the
job.

· No Outlook Security Warnings!
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2 Introduction

The purpose of Outlook-To-ACT Migration Professional is to migrate Outlook databases to
ACT, including groups, activities, journals, and custom fields.

Sub Topics
· Why use Outlook-To-ACT Migration Professional
· Help  on Outlook-To-ACT Migration Professional
· What is new with V4.0
· How to buy

2.1 Why Use Outlook-To-ACT Migration Professional

Outlook-To-ACT Migration Professional is the most comprehensive software program to bring
over an Outlook database to ACT!.

Full Field Remapping
Don't lose any data on your conversion. Bring over all your custom user fields from Outlook to
ACT!. Easy field remapping technology makes discovery and mapping of Outlook fields a breeze
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Ease of Use
Install and in less that 1 minute you could be importing the data you need into your database with
full control of where, how, and which fields you want to import. Our interface makes imports as
easy as possible.

Categories-To-Groups Mapping
Map your Outlook categories into ACT! groups. Full update mapping of Group membership in ACT!

Address Analyzer and Breakup
Map all the fields in the Outlook Address to the corresponding ACT! fields

Notes, Tasks, Calendar and Quick Notes transfer
Bring what is essentially the whole database into related records in ACT!, including the notes for
the contact.

Intelligent Phone Number migration
Bring over all the phone numbers from Outlook, including number in letter format i.e. 1-800-MY-
PHONE to ACT!. In addition, our phone number analyzer identifies and maps phone number
extensions to your ACT! database.

Update matching contacts.
Our proprietary contact matching allows you to always update the contact that is related to the
Outlook contact. Once a match has been done, that contact has a 1-to-1 relationship with the
Outlook Contact

2.2 Help on Outlook-To-ACT Migration Professional

 You can obtain help for Outlook-To-ACT Migration Professional in the following ways:

· The help file shipped with the product. The help file provided with Outlook-To-ACT Migration
Professional is the most recent help file when this version of Outlook-To-ACT Migration
Professional was created. We provide, an online version of this help file which may be more up-
to-date than the shipped version

· The online help file. This is the most updated version of the help file. When additions and
changes are made to the help file, they are always posted on the online help file. To access it,
click here.

· Printed Version of this Help File. You can download the made-for-print version of this help file
from the web by clicking here. You will need to have the Adobe .pdf reader installed on your
system. To download the Adobe .pdf reader, click here. To print the manual, click on the print
button of the .pdf reader and the manual will then be printed on your local printer.

· Outlook-To-ACT Migration Professional Discussion Board. Participate on PersonalCRM's
discussion board free of charge and pose questions and exchange ideas with other users of
Outlook-To-ACT Migration Professional. All discussion threads are monitored by
PersonalCRM's personnel and you will receive answers to questions that relate to product
installation, setup, and use. To access the discussion board, click here.

· Email Support. You can obtain free email support from PersonalCRM. Make sure that you
explain your problem/question with as much detail as possible. You can either send the email to
outlook2actprosupport@personalcrm.com, or use the support form by clicking here.
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· Personalized, one-on-one support. PersonalCRM will provide personalized, one-on-one
support to paying customers. Support is provided on an hourly basis. If you are interested on
one-on-one support, you can purchase it by clicking here. A support professional will call you
(US Only). If you are based outside the U.S., schedule a time to call so that we can make sure
the best support person is available to receive your call.

· Suggestions. PersonalCRM is driven to provide software solutions that will satisfy our
customers. Your input is important to us and we want you to contact us if you have any
suggestions on added features or even improvements we can make to our products in order to
make them better. Please click here to submit a suggestion.

2.3 What is New With V6.0

 Version 4.0 of Outlook-To-ACT Migration Professional has added some key components that
improve importing data into ACT!.

Major Features

· Added support to import Outlook Journal entries. The Outlook journal entries are attached
to the contacts related to the entries.

· Improved Help Functionality. New local and web help eases the use of Outlook-To-ACT
Migration Professional.

· Event Selection Improvements. Filter out which contact events you want to import by date
and type.

· Duplicate Actions. We've speeded up duplicate finding. In addition, we've added 3rd string
duplicate finding:

1. Find duplicates by Full Name match.
2. Find duplicates by Full Name and Company match.
3.    Find duplicates by Full Name, Company and City.
4. Find duplicates by Full Name and City.

· Outlook Filtering. We've added the capabilities for users to filter which contacts in Outlook to
convert.

·  Speed, speed, speed. Multiple improvements in data management have been introduced to
improve processing speed.

· Installation. Our installation now takes less than 1 minutes and you are up and running before
you know it.

· More Conversion Options. Specialized phone number management, support for Outlook
Alpha numbers, and full field remapping are now standard features.

Bugs Fixed
· Fixed the tagging mechanism for Appointments and Tasks which were rendering Outlook

Appointments and Tasks into repetitive mode.
· Fixed the phone number parsing mechanism
· Fixed bringing over independent Journal Entries
· Fixed duplicate checker
· and much more....
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2.4 How to Buy Outlook-To-ACT Migration Professional

Outlook-To-ACT Migration Professional is distributed worldwide by a variety of resellers
and distributors.

To Purchase
Click on the Registration->Purchase menu option of Outlook-To-ACT Migration
Professional and you will be taken to the purchase page for the product.

PersonalCRM Home page
http://www.personalcrm.com

Email support
support@personalcrm.com

Snail mail
PersonalCRM Inc.
891 Quetta Court
Sunnyvale, CA 94087

Fax
USA: (240)220-3244
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3 Installation

Installation of Outlook-To-ACT Migration Professional is straightforward. The following is needed

· You'll need approximately 8mb of hard disk space
· ACT Installed on your system
· Administrator Privilege if running Windows XP, XP Pro, and 2000

To install, simply execute the Outlook-To-ACT Migration Professional executable and follow the
directions to install the program.

Sub-topics

Outlook-To-ACT Migration Professional for ACT! Compatibility
Lists the system with which Outlook-To-ACT Migration Professional is compatible with

License Registration
Instructions on the procedures on registering Outlook-To-ACT Migration Professional

End-User License Agreement

Uninstall

3.1 Compatability

Outlook-To-ACT Migration Professional is an Addon Product for ACT!. Hence, it requires the user to
have ACT! installed in the machine. Outlook-To-ACT Migration Professional is compatible with ACT!
2000 or above.

ACT! 2000/6.0 compatibility

Outlook-To-ACT Migration Professional is compatible with the following versions of ACT!:
· ACT! 2000 with Service Pack 5.0.4.495 or 5.0.3
· ACT! 6.0 - All versions.

Outlook-To-ACT Migration Professional may not work with ACT! 2000 without a service pack
i.e. build 5.0.0. The programming interface in the original ACT! version has posed problems
with Outlook-To-ACT Migration Professional and we suggest that if you are running an original
version of ACT!, that you upgrade.

What to do if you have the original ACT! 5.0.0 build?
You have to upgrade to ACT! to Version 5.0.4.495. The upgrade may be obtained for free from
act.com. Download the software (16mb) and execute it.

From our tests, V 5.0.4.495 has shown to be very reliable.

How to find out what version/build of ACT! you are running
To find out what version of ACT! you are running, do the following:

1. Click on Help->About ACT! on the ACT! Contact Screen
2. Check the Build Number on the right hand corner of the About Screen. The number of the

build has to be higher that 5.0.0.X which is the original release of ACT! 2000.

Outlook Compatibility
Outlook-To-ACT Migration Professional is compatible with Outlook 2000 SP-1 and above, 2002 and
2003
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Operating System Compatibility
Outlook-To-ACT Migration Professional is compatible with the following Windows operating
systems:
· Windows 98
· Windows 98 - SE
· Windows Me
· Windows 2000
· Windows XP
· Windows XP Professional

3.2 Registration

Purchasing Outlook-To-ACT Migration Professional!
To purchase Outlook-To-ACT Migration Professional, click on the Buy/Purchase Button and it will
take you to the web site for purchase. When the product is purchased, you receive a license code
(some of our partners also call it a Serial Number), indicating that your product has been
purchased and paid for.

To activate Outlook-To-ACT Migration Professional, enter the license supplied with your
purchase.

Activating your Outlook-To-ACT Migration Professional

To activate Outlook-To-ACT Migration Professional, click on the License Activation option and
enter the license that was sent to you.
If you have an active firewall, the license activation may fail to register. If the activation fails, click
on the Activate Registration Via Email and upon receipt of your license number and email
address, PersonalCRM will provide you with activation instructions for your own copy of Outlook-
To-ACT Migration Professional.

Outlook-To-ACT Migration Professional Serial Number
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Outlook-To-ACT Migration Professional has a unique serial number for every PC it is installed on.
The obtain your serial number, click on Help -> About Outlook-To-ACT Migration Professional and
your serial number is listed.



Installation 13

© 2003 PersonalCRM Inc..

13 

3.3 End-User License Agreement

Outlook-To-ACT Migration Professional

LICENSE AGREEMENT - PERSONALCRM Inc.

This is a user license agreement (the "AGREEMENT") between you (either individual or single
entity) and PersonalCRM, Inc., for the version of the software (the "SOFTWARE") accompanying
this AGREEMENT.

The SOFTWARE is the property of PersonaCRM, Inc. and is protected by copyright laws and
international copyright treaties.  The SOFTWARE is not sold, it is licensed.

By availing of any of the rights licensed to you in this AGREEMENT, you agree to be bound by and
are becoming a party to this AGREEMENT.  If you do not agree to these terms and conditions, do
not avail of the rights licensed to you in this AGREEMENT.

If you accept the terms and conditions of this AGREEMENT, you have certain non-exclusive rights
and obligations as follow:

YOU MAY do any of the following:
· Use the Software for the Evaluation Period Provided;
· Use the Software for one SINGLE Computer only and for only 1 user;
· Use the Software on a network, PROVIDED that each person accessing the Software through

the network must have a copy licensed to that person or an authorized network multi-user
license.

· Copy the Software for archival purposes ONLY, provided any copy must contain all the original
Software's proprietary notices.

YOU MAY NOT:
· Permit other individuals to use the Software except under the terms listed above;
· Distribute, reveal, post, or disseminate the license key to any other users;
· Permit concurrent use of the Software except with a multi-user license;
· Modify, translate, reverse engineer, de-compile, disassemble (except to the extent applicable

laws specifically prohibit such restriction), or create derivative works based on  the Software;
· Copy the Software other than as specified above;
· Rent, lease, grant a security interest in or otherwise transfer rights to the Software
· Remove any proprietary notices or labels on the Software or its output;

All other rights with respect to the SOFTWARE are reserved. The SOFTWARE is Copyright (c)
2002 PersonalCRM, Inc. All Rights Reserved

The Software is provided "AS IS", without a warranty of any kind.

ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES,
INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED.
PERSONALCRM, INC. AND IT'S LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES
SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THE
SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL PERSONALCRM, INC. AND IT'S
LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT,
INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER
CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF
OR INABILITY TO USE SOFTWARE, EVEN IF PERSONALCRM, INC. HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.
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PERSONALCRM, INC. DOES NOT INDEMNIFY ANY PARTY TO THIS LICENSE.

IN ANY EVENT, THE MAXIMUM LIMIT OF PERSONALCRM, INC.'S LIABILITY UNDER THIS
AGREEMENT IS $1.

PERSONALCRM, Inc. is not bound by any provision of any purchase order, receipt, acceptance,
confirmation, correspondence, or otherwise, unless  PERSONALCRM, Inc. is specifically agrees to
the provision in writing.  If any provisions, or portions thereof, of this agreement are invalid under
any applicable statute or rule of law, then that portion shall be deemed omitted in the applicable
jurisdiction and the remaining portions of the agreement remain in force.

3.4 Uninstall

To uninstall Outlook-To-ACT Migration Professional, do the following:
· Click on Start->Settings->Control Panel
· Execute Add/Remove Programs from the Control Panel
· Select Outlook-To-ACT Migration Professional from the listed programs
· Click Remove and Outlook-To-ACT Migration Professional will be removed from

your system.

A Few Things
· Installing and Uninstalling will not reset the evaluation period for Outlook-To-ACT

Migration Professional
· Uninstalling Outlook-To-ACT Migration Professional will not reset the conversion

counter
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4 Running Outlook-To-ACT Migration Professional

Click anywhere on the screen shot of Outlook-To-ACT Migration
Professional

 to be taken to the topic relevant to that area.

Before you are fully acquainted with Outlook-To-ACT Migration Professional for ACT!, it is
recommended you backup the database in case any of the import is done erroneously.

Sub-Topics

· File Menu
· Help Menu
· Conversion Buttons
· Tabs
· Performance
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4.1 File Menu

The File Menu provides users with 5 options:
1. Select Contact to Convert. This is the same as pressing the Select button. It displays all the

contacts in the Outlook Contact database that are available to be converted.
2. Convert All Contacts. This is the same as pressing the Convert All button. It processes all the

contacts that are available in the Outlook find.
3. Open ACT! Database. This is the same as the Browse button. It provides the user with a

selection screen to find the database to import.
4. Re-Open Database. This will close the selected database and open it again.
5. Exit. Exit Outlook-To-ACT Migration Professional.
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4.2 Help Menu

The help menu has 3 options:

· Topic Help - This is the help shipped with Outlook-To-ACT Migration Professional.
· Online Help - Click here to access the online help. This help system is updated regularly with the

latest additions/changes.
· About Outlook-To-ACT Migration Professional. Click here to find out the information about the

current version of Outlook-To-ACT Migration Professional that you are running.

4.3 Conversion Buttons

The Conversion Buttons are the buttons that are accessible by the user so convert the whole database
or selected contacts in the database.

· Select. Click here to get a list of all the contacts that can be converted.
Important: The list in Select Contacts is created from the Outlook Filter set in the Filters Tab.

· Convert All. Convert All will convert all the contacts in the Outlook Database (restricted by the
Outlook Filter in the Filters Tab).

During the Evaluation of Outlook-To-ACT Migration Professional, the Convert All
button is disabled. You can only perform selective conversions
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4.3.1 Select Contacts

By pressing the Select button, the selective contact conversion windows pops up. You can select one
or many contacts to convert. To convert simply press the convert button.

4.3.2 Convert All Contacts

When the convert all contacts is pressed, all the contacts in the Outlook database (restricted by the
Outlook Filter) are converted into ACT! contacts.

4.4 Tabs

The different conversion options are accessed by clicking the appropriate tab selection:
Outlook Folders: Setup where you want to retrieve the information in Outlook
Conversion Options: Setup the options to use in this conversion
Contact Fields: Field Remapping tab to tab any and all fields in Outlook to the ACT! equivalent.
Filters: Set a filter to filter out the selection of Outlook contacts
Activities: Select whether you want to convert Calendar, Tasks, Notes or Journal items from
Outlook
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4.4.1 Outlook Folders

Here you select the folder in Outlook from where Outlook-To-ACT Migration Professional obtains data.
By click on Pick Folder, you are presented with an Outlook folder representation to retrieve the relevant
folder. Make sure that you retrieve a folder that is of the type being requested, otherwise an error is
generated.

4.4.2 Conversion Options

Click anywhere on the Options Group to find out about the options for that
heading.
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Conversion options provides you with a set of options used when converting.

Duplicate Found Actions
Check for Duplicates. This instructs Outlook-To-ACT Migration Professional to check for
duplicates during the conversion. Duplicate checking is done as follows:

· First, the Outlook contact is analyzed whether it has been converted to ACT! before. If
this is true, the contact in ACT! is then updated with the information from Outlook.

· Second, if no match has been found, check whether there is an Email Address in ACT!
that matches the contact in Outlook.

· Third and last duplicate check. Check if we can find a contact using the Duplicate
Finding Strategy.

· If none of the above searches come with a positive match, then a new contact is
created.

Enable Intelligent Updater. When selected, Outlook-To-ACT Migration Professional will only
analyze Outlook contacts to be transferred if the Modification Date of that contact is
more recent since the last conversion.

Phone Extension Prefix
The phone extension prefix is the alphanumeric character you use when entering a phone number
extension in the same line as the phone number i.e. (408)555-1212 ext. 123 . In this case, the
software will look for the extension prefix and enter the phone extension into the appropriate ACT!
phone extension field. In addition, extension prefixes such e and ex are automatically scanned in
the Outlook Phone Number

Addressing Options
Country Code: Enter the country code used.

Intelligent Address Conversion. When enabled, the address from Outlook is split up into
fields and entered into the ACT! contact fields. For example, an Outlook address looks like
234 Street Ave., Suite 234, P.O. Box 893 . When this option is enabled, these fields are
mapped into ACT! in the following way:

 ACT! Address 1 Field: 234 Street Ave.
 ACT! Address 2 Field: Suite 234
 ACT! Address 3 Field: P.O. Box 893

Make Salutation for ACT! First Name. Outlook does not have the concept of Salutation.
Also, in many instances, Outlook does not provide for the first name to come over. Setting
this option, you ensure that the first name of the contact is set to the Salutation in ACT!

Options
Convert Outlook Categories into ACT! Groups. When set, this option converts the Outlook
Categories into ACT! Groups with the contact being a member of that group. If Full Group
Update is unset, the group information is added (cumulative) to the current ACT! group



Outlook-To-ACT Migration Professional22

© 2003 PersonalCRM Inc..

22 

membership.

Full Group Update. When set, it instructs Outlook-To-ACT Migration Professional to fully update
the group membership of the contact in ACT!.
Convert Body Text into ACT! History. When set, this option converts the body text of an Outlook
Contact (the notes on the Contact Window) into an ACT! History Event named "Contact Note
From Outlook" on the subject line.

4.4.3 Contact Fields

The contact fields tab allows you to map fields in Outlook to different fields
in ACT!, Field remapping. This is specially useful when you have many
user defined fields that you want to bring over to ACT!.

The fields are of 4 different types:
"s" – String
"d" – Date
"n" – Number
"p" – Phone number

It is recommended that you when performing the conversion, the field types be the same.

Mapping/Unmapping Fields
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To Map a field over do the following:
1. Check mark the field you want to remap
2. Select the ACT! field
3. Select the Outlook field from the list. If the field is not listed and/or is

a user defined field, click on the Retrieve Outlook User Defined
Fields to retrieve the field from Outlook.

4. Click on the < button to remap the field

To Unmap a field:
1.  Select the field (step 2)
2. Click on the > to move the field back to Outlook

Retrieving User Defined Outlook Fields

All Outlook User Defined Fields are displayed in Bold in the field list. Outlook-To-ACT
Professional allows the user to retrieve user defined fields that exist in Outlook.

Retrieve User Properties from Existing Contacts.
If you have Outlook contacts that have the user defined fields that you
want, you can search Outlook for these fields using this option. This option
creates a screen that displays all the contacts in the Outlook Contact
Database and when you click on the contact, it will display the user fields
defined for that contact
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By clicking on the contact, this screen displays the user defined fields found for the contact. Note: if
the user defined field has an empty value, Outlook does not see it as a user defined field and it
will not appear in the list!

To add these user fields to the list of user fields that you want to create, select the Add Outlook User
Fields button.

4.4.4 Filters

Outlook filters are filters that allow you to select a specific range of Outlook
contacts to migrate over to ACT!. There filters are executed first before a
conversion is made. To view the result of the contacts selected, click on
the Selected option and a full count of the results of the Outlook Filters is
displayed.
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An empty filter (<None>) indicates all contacts.

An error is generated if a problem is encountered with the filters and the
filters will have to be modified to result on a positive result.

4.4.5 Activities

The Activities tab allow you to select which Outlook Activities to bring over to ACT!. There are two
types of Activities:

1. Dependant Activities. These are activities that are directly related to a contact i.e. at the bottom
of the activity, it specifies which contact the activity has been scheduled with. There activities
are mapped to the resulting ACT! contact.

2. Independent Activities. These activities are independent of contacts i.e. they have not been
assigned to any contact in Outlook. These activities are brought over under ownership of My
Contact.

Calendar, Tasks, and Quick Notes are brought to ACT! as Meetings, Todo's and History Notes
respectively. However, Journal Items are brought over to ACT! as history items for the contact but as
attachments for that contact.

4.5 Performance

Unfortunately, due to the underlying speed of Outlook and ACT!, Outlook-To-ACT Migration
Professional is fully dependent on the speed of these software packages. Hence, it is recommended
that you run the software on a local database using Outlook locally. Otherwise, speed will be a major
factor. Outlook-To-ACT Migration Professional is not a speed daemon. We perform a large number of
checks before we bring the data over and Outlook in conjunction with ACT! does not promote fast
processing.

If you are creating a brand new database, disable Duplicate checking and conversion process will
speed up significantly since no need to perform duplicate checking is necessary.

4.6 ACT and Outlook Fields
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5 Tips and Tricks

The examples below lists a few of the applications of Outlook-To-ACT Migration Professional for ACT!.

This section keeps expanding as we receive more requests from users for explanations. Check the
web help for any updates.

Subtopics
Phone Numbers
Journal

5.1 Phone Numbers

ACT! is very particular with Phone numbers while Outlook is very liberal with phone numbers. The
following types of phone numbers will successfully be converted into ACT! phone numbers:

· Any numeric phone number i.e. (408)555-1212
· Any alpha number i.e. 1-800-MY-PHONE
· Any number with an extension i.e. (408)555-1212 ext: 234, or (408)555-1212 ext. 234

Phone numbers that will not come up as expected:
· Double Phone numbers on the same field i.e. (408)555-1212, (408)555-1213 . The first number

will be correct until 1212 and then the second phone number is added to the remainder phone
number

· Extensions that have no visible delimiter i.e. (408)555-1212 123 . The 123 string will be added to
the phone number (unless a space is setup as an extension delimiter.

5.2 Journal

Journal entries in Outlook range a vast myriad of items from Emails, Notes, Calendar items, etc..
Hence, all journal items are transferred to ACT! in attachment format i.e. as an attachment to the
history of the contact. In order to view these items, click on the item icon and the appropriate Outlook
viewer is then selected to display the item.
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